Peer Review Guide for Project-Based Team Writing

John-Michael Davis
Worcester Polytechnic Institute
Department of Integrative and Global Studies
jdavis4@wpi.edu

Revising a team-based academic research paper presents multiple challenges. Students are often given general advice to improve their prose: create a logical narrative, be concise, use the active tense and a variety of verbs, make references clear, use effective topic sentences, etc. Yet, for new writers, a laundry list of good writing practices can seem overwhelming, even debilitating, to improve their paper. Complicating matters is the challenge of writing a coherent document within a team and tactfully offering constructive criticism for co-authors.

The following team-based peer review guides are intended to address these challenges by sensitizing students to common writing errors and offering a straightforward approach to revise them, while providing direction on how to offer thoughtful comments for co-authors. The peer review guides contain four exercises that offer a step-by-step approach to support student’s revision process as they move from macro-level, big picture structural revisions to meso-level scrutiny at the paragraph level to micro-level line-editing. The four exercises are designed to be completed sequentially as students progress through their writing, but they can also be completed independently on an as needed basis. The four exercises are listed in sequential order below:

1. **Reverse Outline:** Addresses macro-level issues with writing by effectively rearranging ideas to produce a well-structured and cohesive document.
2. **Topic Sentences:** Guides students to develop effective topic sentences that articulate a clear subject and controlling idea that align with the remainder of the paragraph.
3. **Evidence-Based Writing:** Analyzes and improves evidence to support and develop assertions, enhancing the credibility and strength of arguments.
4. **Line Editing:** Makes the task of line editing less daunting by offering a method to enter sentences, identify common problems, and offer simple solutions to make the writing concise, clear, and direct.

Remember that feedback is a gift! Effective writing is a continuous learning process and incorporating feedback from peers is an invaluable part of that journey. As students review each other’s writing through these peer review exercises, encourage open and respectful dialogue within teams. When completed with diligence and positive intentions, these exercises can foster a collaborative learning environment and provide a broader perspective on the strengths and weaknesses of student writing, ultimately producing a stronger research paper.
Peer Review Guide: Reverse Outline

Overview

Creating a coherent narrative that logically arranges ideas for the reader is a common writing challenge, complicated by writing in a team. Team members often write independent sections, which are then pasted together, increasing the likelihood of needless repetition and poor sequencing. Once students have written the first draft, it can be challenging to defamiliarize themselves with their own thought process, rearrange ideas, and think through the reader’s perspective.

This peer-review exercise will help teams address the macro-level structure of their writing through a reverse outline exercise. The reverse outline exercise involves creating an outline or “skeleton” based on what students have already written. Unlike the traditional process of transforming an outline into a text, a reverse outline transforms a text into an outline. By creating an after-the-fact outline of a draft, students can more easily scrutinize what they’ve said and where, enabling them to identify structural issues to remedy. This exercise will help create an objective distance with the writing to see the bigger picture, and effectively arrange ideas to produce a well-structured and cohesive document.

Reverse Outline Peer-Review Instructions

1. Print out your draft text with a wide margin. In a Microsoft Word document, you can create custom margins by clicking on the “Layout” tab, under the “Page Setup” group, click on the “Margins” icon. Choose custom Margins and set the value for the left margin at 6 cm, for example. Click OK. Alternatively, you may feel more comfortable working with an electronic document and using the “comment” feature to mark up your writing.

2. Number each paragraph and write the topic or main idea of each paragraph in the margin. Since you are reviewing an early draft, this process will be challenging; not all paragraphs will have clear topics and not all topics will be expressed neatly in a paragraph. At this stage, identify what is there rather than what ought to be there. This is a diagnostic step, not the place for judging or remediying. Once you’ve written the main topic of the paragraph, identify the word count of the paragraph.

3. Arrange your paragraph topic sentences into an outline on a new document. To create your preliminary outline, you are simply listing the topics that you’ve identified, paragraph-by-paragraph. This process will help minimize the muddling effect of mixing your previous detailed writing into your revised outline.

4. Analyze the outline. In this step you will review the logic and proportionality of your outline. This step is the bridge between noting what you have and preparing to create something new. Ask yourself the following questions:

   a. Does every paragraph directly relate to your main idea? Many writers find that new ideas appear near the end of a reverse outline. These topic shifts may signal that you need to cut or revise certain paragraphs to ensure they relate back to your main idea, or they may inspire you to revise your main idea, so it encompasses some of the new points these paragraphs discuss.

---

b. Where might a reader have trouble following the order of your ideas? Review the organization of your writing and make strategic choices to rearrange the paper on a paragraph-by-paragraph basis or add or remove paragraphs to improve organization. Think about your sequencing and what a reader will need to know first to make sense of what you will discuss later.

c. Do several of your paragraphs repeat one idea? If two paragraphs make similar points, consider combining them or revising one so that it is not needlessly repetitive.

d. Does one paragraph juggle several topics? If one paragraph discusses more topics than other paragraphs, that may be a paragraph your reader will struggle to follow. By dividing its topics into two or more paragraphs, each one discussing a contained topic or set of topics, you may help the reader follow your meaning.

e. Are your paragraphs too long or too short? By comparing the word count of paragraphs, you can learn your average paragraph length and spot paragraphs that are unusually long or short.

After you complete the first four steps, meet with your team to discuss and consolidate your results. Then, as a team, complete a revised outline following Step 5. Consider using different methods to visualize your outline. For example, you may benefit from using index cards or sticky notes, a simple mind mapping software (e.g., FreeMind), a whiteboard, a large projector screen, or any other means that helps you conceptualize the structure of your writing.

5. Create a revised outline. Now that you can see all the topics in your report and can identify weaknesses in either the ordering or allocation of space, you are ready to create a better outline. You have the best of both worlds at this point: you know a great deal that you didn’t know before you started writing, but you are still working at a level of abstraction that will keep you from getting bogged down in the details.

Once you have completed your revised outline, your team can divide up sections of your text and independently complete Steps 6 & 7, reorganizing your writing according to the revised outline.

6. Reorganize the text according to the revised outline. This is the hard part! It’s time to use your new outline to transform the text. Your initial draft, even with all its flaws, will likely have a real hold on you, stemming from a legitimate fear that you might take away existing coherence without being able to replace it with something better. Have faith! Both in your new outline and your ability to transform your writing into something better. Practically, in this step you are moving the text around to reflect the revised outline’s organization. The initial result can be rough. For example, if you move a few paragraphs from the second half of the paper to an earlier section, they can’t possibly sit right. The time for massaging everything into a cohesive whole will come, but for now you must trust that the new outline will produce an improved configuration of your text.

7. Check for topic sentences and cohesion. The final step involves paying attention to the way your new paragraphs work. The new configuration will be both better and worse. It will be better because it reflects your careful analysis of what it needs to do; it will be worse because it still bears too many traces of its earlier self. At this point, identify whether you have effective topic sentences and whether your paragraphs use their length effectively to develop clear topics. Polishing a text is time-consuming work, but it is easier and more efficient when you are working on a text that is organized well.
Peer Review Guide: Topic Sentences

Overview
This peer-review guide focuses on writing effective topic sentences. These concise statements act as signposts, guiding readers through your ideas and arguments. By crafting effective topic sentences, you enhance clarity, coherence, and engagement in your writing. An exercise on topic sentences may seem elementary, but it's a common challenge that can evade even experienced writers. As a primer to this peer-review guide, you will learn about the two main components of an effective topic sentence: the subject and controlling idea. Then, you will review your team writing and scrutinize your topic sentences.

The Topic Sentence: Subject & Controlling Idea
The topic sentence typically consists of two parts: the topic itself and the controlling idea. The topic represents the subject of the paragraph, while the controlling idea provides a specific direction for the paragraph. The controlling idea can take two forms. It may reveal the writer's opinion, point of view, or attitude toward the subject, setting parameters for the discussion, or it may provide specific limitations on the scope of the paragraph. In both cases, the controlling idea unifies the paragraph by providing a focus, allowing the reader to anticipate the content and direction of the paragraph. Below is an example of an effective topic sentence and what the reader would expect the body of the paragraph to discuss:

Topic Sentence: Rising global temperatures caused by greenhouse gas emissions pose a significant threat to coastal communities vulnerable to sea-level rise.

- **Subject:** The impact of rising global temperatures caused by greenhouse gas emissions.
- **Controlling Idea:** The significant threat posed to coastal communities vulnerable to sea-level rise.

This topic sentence effectively introduces climate change and its consequences to the reader, highlighting the impact on coastal communities. It sets the stage for discussing the relationship between rising global temperatures, greenhouse gas emissions, and the increased risk of sea-level rise. By emphasizing the threat posed to vulnerable coastal areas, the controlling idea establishes the direction of the paragraph, providing a clear framework for the subsequent supporting details and arguments.

In addition to including a subject and controlling idea, effective topic sentences exhibit certain qualities:

1. They offer new information rather than stating obvious facts that the reader already knows.
   a. Bad: Observation techniques have been used to learn about visitor engagement in museums.

2. They are specific enough to give the reader a clear expectation of what will be discussed in the paragraph.
   a. Bad: Community asset mapping is a research method used to assess community resources.
b. Better: Community asset mapping involves four phases to identify and leverage local resources for effective community development.

3. They start with strong language instead of weak openers like "There is/are."
   a. Bad: There are various methods to assess the spiciness of food.
   b. Better: A variety of methods, such as taste tests and Scoville scale measurements, accurately assess the spiciness levels in food.

4. They are stated in positive language, avoiding negative phrasing.
   a. Bad: The history of ComicCon is not lacking in controversies and setbacks.
   b. Better: ComicCon's controversial history and enduring popularity highlight its impact as a premier pop culture celebration.

5. They avoid being mere announcements, instead drawing the reader into the paragraph.
   a. Bad: This paragraph will discuss creating robotics curriculum for children.
   b. Better: Integrating hands-on activities and problem-solving challenges, a well-designed robotics curriculum can spark creativity and critical thinking skills in children.

**Topic Sentence Peer-Review Instructions**

Follow the instructions below to complete the topic sentence peer review exercise. To begin, divide sections of your paper so that each team member has several paragraphs to review that another team member wrote. Each team member will complete the following steps independently, reviewing one paragraph at a time:

1. Read the topic sentence of the first paragraph carefully – do not read the body of the paragraph yet. Write the subject and controlling idea of the topic sentence as best as you can, as demonstrated in the previous section.
2. Before reading the rest of the paragraph, think about what you would expect the remainder of the paragraph to discuss based on the topic sentence alone.
3. Now, read the paragraph and evaluate whether it effectively supports or elaborates on the subject and controlling idea of the topic sentence. Consider the relevance and coherence between the topic sentence and the paragraph's content.
4. Provide constructive feedback on any discrepancies you identify. Offer suggestions on how the paragraph's content could be revised or improved to align more closely with the topic sentence or if the topic sentence should be revised to better frame the content of the paragraph.
5. Move on to the next paragraphs and repeat steps 1-4.
6. Once all teammates have completed their topic sentence reviews, meet in person and work through your entire paper, paragraph-by-paragraph, to discuss feedback and suggestions for improvement.
7. The primary authors can then revise their paragraphs based on the feedback received to align the topic sentences with the content of each paragraph.
Overview

Good academic writing is “evidence-based,” which means it calls on external sources to support claims and convince the reader an argument is valid. Evidence-based writing provides credibility and can strengthen an argument; without evidence, academic writing appears uninformed, and the argument is weak. Strong writing requires robust evidence to support and develop claims because without evidence, a claim is merely an unsubstantiated idea. Evidence becomes especially effective when the writer leads the reader through their reasoning. The process of putting together an argument is called analysis – it interprets evidence to support or refine claims. Thus, the essential components of a written argument are the claim, supporting evidence, and reasons that explain how the evidence supports the claim.

This evidence-based writing peer review guide focuses your attention on scrutinizing the evidence used to support and develop your assertions. Through this exercise you will identify claims or assertions, the supportive evidence, and whether an explicit relation between the evidence and claim is made. Finally, you will review your citations to ensure they are accurate and well-positioned in your text. Before introducing the peer review evidence-based writing exercise, I’ve provided a brief overview of best practices for evidence-based writing.

Best Practices in Evidence-Based Writing

In academic writing there are several types of evidence with differing levels of strength that writers employ to build arguments and substantiate claims. Typically, the bulk of your evidence should be derived from peer-reviewed, scholarly sources that encompass articles and books authored by experts in the field. However, other sources, such as government data, professional reports, historical data, and newspapers can offer valuable sources of evidence as well. Statistics from peer-reviewed, or otherwise reputable sources, are a powerful means to support your claims. Note that statistics may require qualifications to inform the reader of any limitations regarding their credibility (e.g., indicating that a study had a low or biased sample). Other, less rigorous, types of evidence can offer additional dimensions to support your claims and could include the following:

1) **Anecdotal evidence** includes stories or case studies from external sources that support your assertion. These are often used as a hook to form a connection with the reader.

2) **Testimonial evidence** involves relevant subject expert opinions that support your claims. This form of evidence requires the writer to establish credibility for the expert and often involves quoting seminal work on the topic.

3) **Analogical evidence** involves comparing something that is not certain or known with a situation that is known and drawing conclusions based on that comparison. While this is a weaker form of evidence, in a subject with little published research, it can be a compelling means to support your claim if you can make a strong case for the similarities between the situations being compared.
While the traditional approach to evidence-based writing is to identify facts and studies that directly support your claims; there are alternative ways to work evidence into your writing. Consider using the following rhetorical moves:

- Offer evidence that supports your assertion up to a point, then build in ideas of your own.
- Present evidence that contradicts your stance, and then argue against (refute) that evidence and therefore strengthen your position. This demonstrates that you have fully researched your topic and can counter claims against your argument.
- Use sources against each other, as if they were experts on a panel discussing your proposition.
- Use quotations to support your assertion, not merely to restate your claim.

Once you find convincing evidence to support your argument, the next step is to ensure there is a clear and logical relation between the evidence and claim. Evidence does not speak for itself: readers may draw unintended conclusions or may not understand how the evidence relates to the claim. It is the writer’s job to walk the reader through the significance of the evidence to the claim and its connection to the broader argument. In short, you need a reason why the evidence supports the claim – you need to analyze the evidence. Below, I’ve provided a weak and strong example for how to use evidence in your writing.

**Weak use of evidence**

Today, western society is too self-centered. Many families no longer eat dinner together at the table, preferring to eat on the go (Maxwell, 2017). Everything is about what we want.

This is a weak example of evidence because the evidence is not related to the claim. What does the claim about self-centeredness have to do with families eating together? The writer doesn't explain the connection. The same evidence can be used to support the same claim, but only with the addition of a clear connection between claim and evidence, and some analysis of the evidence cited.

**Stronger use of evidence**

Americans are becoming increasingly self-centered. Even our families don't matter as much as they once did. Other people and activities take precedence. For example, Maxwell (2017) found that 72% of American families no longer eat together, preferring instead to eat on the go while rushing to the next appointment. Sit-down meals are a time to share and connect with others; however, that connection has become less valued, as families begin to prize individual activities over shared time, promoting self-centeredness over group identity.

This is a far better example, as the evidence is more smoothly integrated into the text, the link between the claim and the evidence is strengthened, and the evidence itself is analyzed to provide support for the claim.
A final note on citations. Within your report, evidence will appear in the form of quotations and paraphrasing. Both forms of evidence must be cited in your text. Citing evidence means distinguishing other writers’ information from your own ideas and giving credit to your sources. There are several ways to build citations into your writing to create a clear, concise, and compelling narrative. Below, I’ve offered several examples for lead-in phrases and punctuation:

- **Quoting:** According to Johnson & Brown (2019), "[direct quotation]."
- **Paraphrasing:** Although Perez et al. (2021) argue that [his/her point in your own words], Chen & Williams (2022) found that [their point in your own words].
- **Summarizing:** In her seminal book, Mary Davidson (2008) demonstrates that international trade policy has limited waste entrepreneurs in low-income countries.
- **Aggregating:** Citizen science researchers have long wrestled with gaining legitimacy for their research and, ultimately, policy reform (Bernard et al., 2021; Garb & Lopez, 2018; Stevens et al., 2020)

**Evidence-Based Writing Peer-Review Instructions**

Follow the instructions below to complete the peer review: evidence-based writing exercise. To begin, divide sections of your paper so that each team member has several paragraphs to review that another team member wrote. Note that the methods section in your report may not be suitable to review for evidence-based writing. Each team member will complete the following steps independently, reviewing one paragraph at a time:

1. Read the topic sentence of the first paragraph carefully and identify the claim and controlling idea of the paragraph.
2. Then, read the remainder of the paragraph to identify the evidence used to support the claim. Answer the following questions and offer detailed suggestions for your co-authors:
   a. What kind of evidence is used to substantiate the claim? Are there opportunities to use stronger, more compelling forms of evidence?
   b. Has the writer thoroughly explained why/how the evidence supports their claims? Are there opportunities to strengthen the relation between evidence and claim?
   c. Are the citations to external sources accurate and well positioned within the text?
3. Move on to the next paragraphs and repeat steps 1-2.
4. Once all teammates have completed their reviews, meet in person and work through your entire paper, paragraph-by-paragraph, to discuss feedback and suggestions for improvement.
5. The primary authors can then revise their paragraphs based on the feedback received to better support claims or improve the clarity and significance of evidence presented.
Peer Review Guide: Line Editing

Overview

This peer-review line editing exercise focuses on micro-structure revising, often referred to as editing or proofreading, in which you analyze individual words and sentences for opportunities to improve grammar, punctuation, spelling, and diction. When people talk about “good writing,” they often mean that the piece is working at the microstructure level, without grammatical errors or awkward phrasing. Learning to edit your own and team members writing is critical. Good writing can (unfortunately) cover up bad research and ideas, but good research usually cannot carry a badly written paper.

The purpose of this exercise is to make the task of line editing less daunting by giving you a method to enter sentences, identify some straightforward problems, and offer simple solutions that make your writing briefer, clearer, or stronger. This exercise is designed with speed in mind. While some will insist that you must know all the rules to be a good writer, our objective for this exercise is to improve your writing quality as the last step before submitting your report. If you are not used to editing your own writing, starting with small, manageable tasks helps. The more proficient you get at these small corrections, the more skills you will bring to complicated self-editing tasks.

To complete this exercise, you will perform The Belcher Diagnostic Test on your report. The test is based on the principle that certain words signal the possibility of certain problems. If you can focus your revising attention on these signal words and the words around them, you can improve your writing without having to memorize numerous rules. Note that the diagnostic test cannot identify all the places where you could improve your prose. Only long experience reading in your field, studying style and grammar manuals, or taking composition classes can give you all the tools you need to identify and correct poor prose. Seeing any of these signal words does not automatically indicate a problem. Many instances of signal words will be perfectly acceptable. But clusters of signal words do indicate good places to consider revising. To complete The Belcher Diagnostic Test, follow the steps below:

1. Perform The Belcher Diagnostic Test on your research paper. Instructions to run the diagnostic test are provided in the following section. You will find the “Belcher Diagnostic Macro” pasted below and can be accessed as an accompanying text file. After completing The Belcher Diagnostic Test, your paper will be populated with highlighted colors in red, blue, purple, brown, green, and grey. Each color indicates a specific kind of grammatical error that may be troubling your writing. Note that not all highlighted words demand revision.

2. Within your team, assign each team member one section of the paper to review. Each team member should review a section that another team member wrote.

3. Follow the guidelines in this document to review your paper one color at a time and ensure you are revising the document using “track changes.” For example, begin by scrutinizing all words highlighted red, then move on to blue words, then purple, etc.

---

2 This exercise has been adapted from: Belcher, W. L. (2019). Writing your journal article in twelve weeks: A guide to academic publishing success. University of Chicago Press.

© John-Michael Davis 9
4. Once you’ve completed your revisions, submit your revised document with the embedded track changes to your instructor.

Instructions to Run the Belcher Diagnostic Test with Microsoft Word

- Open the text file called “Belcher Diagnostic Macro” or copy the macro code below and save it as a txt file.
- Hit “Control + A” if using Windows or “Command + A” if using a Mac to select all of the text.
- Hit “Control C” to copy the text
- Open a copy of your document in Microsoft Word. I recommend saving a separate copy of the file, just in case something goes wrong.
- Make sure there are no track changes in your document. In the “Review” tab, select “accept all track changes and stop tracking”
- From the main toolbar, click on the developer tab. If you don’t already have developer mode activated, follow these steps:
  - On the File tab, go to Options > Customize Ribbon
  - Under Customize the Ribbon and under Main Tabs, select the Developer check box.
- Within the developer tab, click on “Macros” and you should see a dialog window appear. If you are on a Mac, you can access this window by clicking the “Tools” menu at the top, then select “Macros,” and select “Macros” from the nested list.
- In the “Macros” dialog box, select the top text field “Macro name” and type “Belcher_Diagnostic.” Then hit “enter.”
- This will open a Microsoft Visual Basic Editor window with an empty macro called “Belcher_Diagnostic.”
- Select all the text in the window (or hit “Control + A”) and then press “Control + V” on the keyboard to paste in the code for the Belcher Diagnostic Test.
- Once you’ve pasted in the code, you can close the visual basic editor window, and it will save automatically.
- Now, if you return to the “Macros” menu, you should see the Belcher_Diagnostic appear in the list. Select it from the list by clicking on it and then click the button labelled “run.”
- The Macro may take a few seconds to run based on the length of the document. Once it is finished, you should see a variety of colorful highlights. After your document is highlighted, read the following guide below to analyze your sentences and identify where you need to make revisions.
- When you are done editing and want to turn off the highlights, select all of your text with “Control + A,” navigate to the “home” tab, under the “font” section, click the dropdown arrow next to “text highlight color” and click “no color.”
Revision Guideline

Now that your article is beautifully colored you can begin scrutinizing your writing for opportunities to improve your prose. Review your paper and look for color clusters. The more red, blue, purple, brown, green, and grey words that cluster in a sentence or paragraph, the more likely there are poorly written sentences that can be improved. To address each color cluster, read through the summary below along with the list of quick fixes for weak phrases that follows. Some instances of signal words will be quite correct, some will not.

Red words: redundant doublings and lists. Starting from the beginning of your section, pick the first sentence with several red words. Look carefully at the black words on either side of the red. If they are a doubling, could you delete one of them? If they are a list, could you use a summarizing word instead? If you need the list, does it appear in the right place in the sentence, after being introduced? If it appears in the right place, do the items in the list appear in the correct order (e.g., alphabetically, chronologically)? If the signal words are a run-on sentence, can you correct it? Go through your article asking if the words before or after the red could be deleted or converted.

Blue words: unneeded pronouns. Go back to the beginning of your section and start looking at sentences with several blue words, especially when they appear near green words. Could you delete the blue words (vague pronouns)? Do you need “there are ... that” or “it was ... who” or “it is [word] to [word] that?” The verb “to be” used with “there” and “it” can often be cut.

Purple words: unneeded prepositional phrases. Examine sentences with lots of purple (extra prepositions), especially when they appear with brown words. Look at the words around them. Could you convert them into verbs or modifiers? For instance, “a great number of” could become many. Purple and brown words often appear with empty words like: fact, kind, sort, type, way, form, variety, range, and so on. Sometimes you need them, but delete all you can.

Brown words: floating pronouns. Examine all brown words to make sure that their referent is clear. If this or these appear without a noun, consider adding one. If it is not clear whom they or them refers to, replace the unclear brown pronoun with its noun antecedent. Blue and brown words can often participate in forming dangling participles. If you see brown words close to green words, that may mean a problem with wordiness.

Grey words: empty words. Examine sentences with several grey words, which often are doing little but cluttering up the sentence. Are you using “not” to avoid saying something with strength? Then use the strong words instead. Does a sentence have several negatives? Are you using “very” to intensify a weak adverb instead of picking the right adverb? Use the strong adverb instead. Are words ending in “ly” (e.g., really, actually, definitely) weakening your prose? Delete them.

Green words: weak verbs and passive voice. Examine all green words (weak verbs), especially when they appear close to blue words, to see if they are verbs buried as nouns. If so, try to unbury them. Is that form of the verb to be or to make needed? What about that word ending in ion? If it is just adding clutter, convert it into a verb or delete it. For instance, “this theory is important and makes a contribution to our understanding” could become “this important theory contributes to our understanding.” You can usually improve words with green endings when followed by “that the.” Forms of the verb to be can also signal passive voice. Only use passive
voice when the actor is not important or when the object of the sentence is the subject of the paragraph.

<table>
<thead>
<tr>
<th>Weak Phrase</th>
<th>Improved Phrase</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Red signal words (and/or)</strong></td>
<td></td>
</tr>
<tr>
<td>Are careful or cautious</td>
<td>Are cautious</td>
</tr>
<tr>
<td>Are short or brief</td>
<td>Are brief</td>
</tr>
<tr>
<td><strong>Blue Signal Words (that, it, who, there)</strong></td>
<td></td>
</tr>
<tr>
<td>Due to the fact that</td>
<td>Because</td>
</tr>
<tr>
<td>In the event that</td>
<td>If</td>
</tr>
<tr>
<td>It is those who build</td>
<td>Builders</td>
</tr>
<tr>
<td>In which the cars</td>
<td>When the cars</td>
</tr>
<tr>
<td>The roads that are paved</td>
<td>The paved roads</td>
</tr>
<tr>
<td>The bread that they ate</td>
<td>Their bread</td>
</tr>
<tr>
<td>The plane which flew fast</td>
<td>The fast plane</td>
</tr>
<tr>
<td>The people who ran</td>
<td>The runners</td>
</tr>
<tr>
<td>There are those who</td>
<td>They</td>
</tr>
<tr>
<td><strong>Purple Signal Words (of, by, as, for)</strong></td>
<td></td>
</tr>
<tr>
<td>A small part of</td>
<td>Some</td>
</tr>
<tr>
<td>A variety of</td>
<td>Different</td>
</tr>
<tr>
<td>As a result of</td>
<td>From</td>
</tr>
<tr>
<td>As of</td>
<td>Starting</td>
</tr>
<tr>
<td>As regards</td>
<td>On, for, about</td>
</tr>
<tr>
<td>As to whether</td>
<td>whether</td>
</tr>
<tr>
<td>At the end of</td>
<td>After</td>
</tr>
<tr>
<td>By means of</td>
<td>By</td>
</tr>
<tr>
<td>By way of pulling</td>
<td>To pull</td>
</tr>
<tr>
<td>For a period of</td>
<td>For</td>
</tr>
<tr>
<td>For the purpose of</td>
<td>For</td>
</tr>
<tr>
<td>From the standpoint of</td>
<td>For</td>
</tr>
<tr>
<td>In an effort to</td>
<td>To</td>
</tr>
<tr>
<td>In order to</td>
<td>To</td>
</tr>
<tr>
<td>---------------------------------</td>
<td>-------------------------</td>
</tr>
<tr>
<td>In spite of the fact that</td>
<td>Despite</td>
</tr>
<tr>
<td>In terms of</td>
<td>By, in, of</td>
</tr>
<tr>
<td>In the amount of</td>
<td>For</td>
</tr>
<tr>
<td>In the near future</td>
<td>Soon</td>
</tr>
<tr>
<td>In the vicinity of</td>
<td>Near, about</td>
</tr>
<tr>
<td>In view of</td>
<td>Because</td>
</tr>
<tr>
<td>Of the purpose of the paper</td>
<td>The paper’s purpose</td>
</tr>
<tr>
<td>On the basis of</td>
<td>By, on</td>
</tr>
<tr>
<td>On a regular basis</td>
<td>Regularly</td>
</tr>
<tr>
<td>The number of</td>
<td>Some</td>
</tr>
<tr>
<td>The type of</td>
<td>[delete]</td>
</tr>
<tr>
<td>The great number of</td>
<td>Many</td>
</tr>
<tr>
<td>With respect to</td>
<td>On, for, about</td>
</tr>
<tr>
<td>With the exception of</td>
<td>Except</td>
</tr>
</tbody>
</table>

**Brown Signal Words (this, these, them)**

<table>
<thead>
<tr>
<th>Them</th>
<th>The parents</th>
</tr>
</thead>
<tbody>
<tr>
<td>This is odd</td>
<td>This odd incident</td>
</tr>
<tr>
<td>This was unfortunate</td>
<td>Unfortunately</td>
</tr>
<tr>
<td>These are vital bees</td>
<td>These vital bees</td>
</tr>
<tr>
<td>These kinds of trees</td>
<td>These trees</td>
</tr>
<tr>
<td>Those who are rich</td>
<td>The rich</td>
</tr>
</tbody>
</table>

**Green Signal Words (to be)**

<table>
<thead>
<tr>
<th>Is a cause of</th>
<th>Causes</th>
</tr>
</thead>
<tbody>
<tr>
<td>Is a critic of</td>
<td>Criticized</td>
</tr>
<tr>
<td>Is a need for</td>
<td>Must</td>
</tr>
<tr>
<td>Is applicable to</td>
<td>Applies</td>
</tr>
<tr>
<td>Is indicative of</td>
<td>Shows</td>
</tr>
<tr>
<td>It isn’t always that</td>
<td>Rarely</td>
</tr>
<tr>
<td>It is the case that all</td>
<td>All</td>
</tr>
<tr>
<td>It is unfortunate that</td>
<td>Unfortunately</td>
</tr>
<tr>
<td>It is this which</td>
<td>This</td>
</tr>
<tr>
<td>There are tubes</td>
<td>The tubes cover</td>
</tr>
<tr>
<td>------------------------</td>
<td>-------------------------</td>
</tr>
<tr>
<td>There are birds that</td>
<td>Some birds</td>
</tr>
<tr>
<td>There are cars which</td>
<td>Some cars</td>
</tr>
<tr>
<td>Y was led by X</td>
<td>X led Y</td>
</tr>
</tbody>
</table>

**Green Signal Words (do, make, have)**

<table>
<thead>
<tr>
<th>Do a study of</th>
<th>Study</th>
</tr>
</thead>
<tbody>
<tr>
<td>Had gotten arrested</td>
<td>Was arrested</td>
</tr>
<tr>
<td>Has the ability to</td>
<td>Can</td>
</tr>
<tr>
<td>Has to balance</td>
<td>Must balance</td>
</tr>
<tr>
<td>Have a tendency to</td>
<td>Tend to</td>
</tr>
<tr>
<td>Make a practice of</td>
<td>Habitually</td>
</tr>
<tr>
<td>Make use of</td>
<td>Use</td>
</tr>
<tr>
<td>Perform a dance</td>
<td>Danced</td>
</tr>
<tr>
<td>Provide a loan</td>
<td>Loaned</td>
</tr>
<tr>
<td>Serve as an example</td>
<td>Exemplifies</td>
</tr>
</tbody>
</table>

**Green Signal Words (-ence/-ion)**

<table>
<thead>
<tr>
<th>Had an experience with</th>
<th>Experienced</th>
</tr>
</thead>
<tbody>
<tr>
<td>Explanation of</td>
<td>Explain</td>
</tr>
</tbody>
</table>

**Grey Signal Words (not, very, -ly)**

<table>
<thead>
<tr>
<th>Basically</th>
<th>[delete]</th>
</tr>
</thead>
<tbody>
<tr>
<td>Not different</td>
<td>Similar</td>
</tr>
<tr>
<td>Not many</td>
<td>Few</td>
</tr>
<tr>
<td>Not often</td>
<td>Rarely</td>
</tr>
<tr>
<td>Not very hard</td>
<td>Easy</td>
</tr>
<tr>
<td>Obviously</td>
<td>[delete]</td>
</tr>
</tbody>
</table>

| To repeatedly go       | To go                   |
Belcher Diagnostic Macro

Copy the text below into a txt file. Then, follow the instructions above to run the Macro on your report.

Sub Belcher_Diagnostic_01()
    
    ' Belcher_Diagnostic_01 Macro
    
    ' Macro coded by John T Sherrill, 2015 Purdue University
    ' This work is licensed under a Creative Commons Attribution-NonCommercial-ShareAlike 4.0 International License
    
    Options.DefaultHighlightColorIndex = wdRed
    Selection.Find.ClearFormatting
    Selection.Find.Replacement.ClearFormatting
    Selection.Find.Replacement.Highlight = True
    With Selection.Find
        .Text = "and"
        .Replacement.Text = "^&"
        .Forward = True
        .Wrap = wdFindContinue
        .Format = True
        .MatchCase = False
        .MatchWholeWord = True
        .MatchWildcards = False
        .MatchSoundsLike = False
        .MatchAllWordforms = False
    End With
Selection.Find.Execute Replace:=wdReplaceAll

Options.DefaultHighlightColorIndex = wdRed
Selection.Find.ClearFormatting
Selection.Find.Replacement.ClearFormatting
Selection.Find.Replacement.Highlight = True
With Selection.Find
  .Text = "or"
  .Replacement.Text = "^&"
  .Forward = True
  .Wrap = wdFindContinue
  .Format = True
  .MatchCase = False
  .MatchWholeWord = True
  .MatchWildcards = False
  .MatchSoundsLike = False
  .MatchAllWordForms = False
End With
Selection.Find.Execute Replace:=wdReplaceAll

Options.DefaultHighlightColorIndex = wdBlue
Selection.Find.ClearFormatting
Selection.Find.Replacement.ClearFormatting
Selection.Find.Replacement.Highlight = True
With Selection.Find
  .Text = "there"
  .Replacement.Text = "^&"
  .Forward = True
  .Wrap = wdFindContinue
  .Format = True
  .MatchCase = False
  .MatchWholeWord = True
  .MatchWildcards = False
.MatchSoundsLike = False
.MatchAllWordForms = False
End With
Selection.Find.Execute Replace:=wdReplaceAll

Options.DefaultHighlightColorIndex = wdBlue
Selection.Find.ClearFormatting
Selection.Find.Replacement.ClearFormatting
Selection.Find.Replacement.Highlight = True
With Selection.Find
  .Text = "which"
  .Replacement.Text = "^&"
  .Forward = True
  .Wrap = wdFindContinue
  .Format = True
  .MatchCase = False
  .MatchWholeWord = True
  .MatchWildcards = False
  .MatchSoundsLike = False
  .MatchAllWordForms = False
End With
Selection.Find.Execute Replace:=wdReplaceAll

Options.DefaultHighlightColorIndex = wdBlue
Selection.Find.ClearFormatting
Selection.Find.Replacement.ClearFormatting
Selection.Find.Replacement.Highlight = True
With Selection.Find
  .Text = "who"
  .Replacement.Text = "^&"
  .Forward = True
  .Wrap = wdFindContinue
  .Format = True
.MatchCase = False
.MatchWholeWord = True
.MatchWildcards = False
.MatchSoundsLike = False
.MatchAllWordForms = False
End With
Selection.Find.Execute Replace:=wdReplaceAll

Options.DefaultHighlightColorIndex = wdBlue
Selection.Find.ClearFormatting
Selection.Find.Replacement.ClearFormatting
Selection.Find.Replacement.Highlight = True
End With
Selection.Find.Execute Replace:=wdReplaceAll

Options.DefaultHighlightColorIndex = wdBlue
Selection.Find.ClearFormatting
Selection.Find.Replacement.ClearFormatting
Selection.Find.Replacement.Highlight = True
With Selection.Find
 .Text = "it"
 .Replacement.Text = "^&"
 .Forward = True
 .Wrap = wdFindContinue
 .Format = True
 .MatchCase = False
 .MatchWholeWord = True
 .MatchWildcards = False
 .MatchSoundsLike = False
 .MatchAllWordForms = False
End With
Selection.Find.Execute Replace:=wdReplaceAll

Options.DefaultHighlightColorIndex = wdBlue
Selection.Find.ClearFormatting
Selection.Find.Replacement.ClearFormatting
Selection.Find.Replacement.Highlight = True
With Selection.Find
 .Text = "that"
 .Replacement.Text = "^&"
Forward = True
Wrap = wdFindContinue
Format = True
MatchCase = False
MatchWholeWord = True
MatchWildcards = False
MatchSoundsLike = False
MatchAllWordForms = False

End With
Selection.Find.Execute Replace:=wdReplaceAll

Options.DefaultHighlightColorIndex = wdViolet
Selection.Find.ClearFormatting
Selection.Find.Replacement.ClearFormatting
Selection.Find.Replacement.Highlight = True

With Selection.Find
.Text = "by"
.Replacement.Text = "^&"
 Forward = True
Wrap = wdFindContinue
Format = True
MatchCase = False
MatchWholeWord = True
MatchWildcards = False
MatchSoundsLike = False
MatchAllWordForms = False

End With
Selection.Find.Execute Replace:=wdReplaceAll

Options.DefaultHighlightColorIndex = wdViolet
Selection.Find.ClearFormatting
Selection.Find.Replacement.ClearFormatting
Selection.Find.Replacement.Highlight = True
With Selection.Find
  .Text = "of"
  .Replacement.Text = "^&"
  .Forward = True
  .Wrap = wdFindContinue
  .Format = True
  .MatchCase = False
  .MatchWholeWord = True
  .MatchWildcards = False
  .MatchSoundsLike = False
  .MatchAllWordForms = False
End With
Selection.Find.Execute Replace:=wdReplaceAll

Options.DefaultHighlightColorIndex = wdViolet
Selection.Find.ClearFormatting
Selection.Find.Replacement.ClearFormatting
Selection.Find.Replacement.Highlight = True
With Selection.Find
  .Text = "to"
  .Replacement.Text = "^&"
  .Forward = True
  .Wrap = wdFindContinue
  .Format = True
  .MatchCase = False
  .MatchWholeWord = True
  .MatchWildcards = False
  .MatchSoundsLike = False
  .MatchAllWordForms = False
End With
Selection.Find.Execute Replace:=wdReplaceAll

Options.DefaultHighlightColorIndex = wdViolet
Selection.Find.ClearFormatting
Selection.Find.Replacement.ClearFormatting
Selection.Find.Replacement.Highlight = True
With Selection.Find
    .Text = "for"
    .Replacement.Text = "^&"
    .Forward = True
    .Wrap = wdFindContinue
    .Format = True
    .MatchCase = False
    .MatchWholeWord = True
    .MatchWildcards = False
    .MatchSoundsLike = False
    .MatchAllWordForms = False
End With
Selection.Find.Execute Replace:=wdReplaceAll

Options.DefaultHighlightColorIndex = wdViolet
Selection.Find.ClearFormatting
Selection.Find.Replacement.ClearFormatting
Selection.Find.Replacement.Highlight = True
With Selection.Find
    .Text = "toward"
    .Replacement.Text = "^&"
    .Forward = True
    .Wrap = wdFindContinue
    .Format = True
    .MatchCase = False
    .MatchWholeWord = True
    .MatchWildcards = False
    .MatchSoundsLike = False
    .MatchAllWordForms = False
End With
Selection.Find.Execute Replace:=wdReplaceAll

Options.DefaultHighlightColorIndex = wdViolet
Selection.Find.ClearFormatting
Selection.Find.Replacement.ClearFormatting
Selection.Find.Replacement.Highlight = True
With Selection.Find
    .Text = "on"
    .Replacement.Text = "^&"
    .Forward = True
    .Wrap = wdFindContinue
    .Format = True
    .MatchCase = False
    .MatchWholeWord = True
    .MatchWildcards = False
    .MatchSoundsLike = False
    .MatchAllWordForms = False
End With
Selection.Find.Execute Replace:=wdReplaceAll

Options.DefaultHighlightColorIndex = wdViolet
Selection.Find.ClearFormatting
Selection.Find.Replacement.ClearFormatting
Selection.Find.Replacement.Highlight = True
With Selection.Find
    .Text = "at"
    .Replacement.Text = "^&"
    .Forward = True
    .Wrap = wdFindContinue
    .Format = True
    .MatchCase = False
    .MatchWholeWord = True
    .MatchWildcards = False
.MatchSoundsLike = False
.MatchAllWordForms = False
End With
Selection.Find.Execute Replace:=wdReplaceAll

Options.DefaultHighlightColorIndex = wdViolet
Selection.Find.ClearFormatting
Selection.Find.Replacement.ClearFormatting
Selection.Find.Replacement.Highlight = True
With Selection.Find
  .Text = "from"
  .Replacement.Text = "^&"
  .Forward = True
  .Wrap = wdFindContinue
  .Format = True
  .MatchCase = False
  .MatchWholeWord = True
  .MatchWildcards = False
  .MatchSoundsLike = False
  .MatchAllWordForms = False
End With
Selection.Find.Execute Replace:=wdReplaceAll

Options.DefaultHighlightColorIndex = wdViolet
Selection.Find.ClearFormatting
Selection.Find.Replacement.ClearFormatting
Selection.Find.Replacement.Highlight = True
With Selection.Find
  .Text = "in"
  .Replacement.Text = "^&"
  .Forward = True
  .Wrap = wdFindContinue
  .Format = True
© John-Michael Davis
.MatchCase = False
.MatchWholeWord = True
.MatchWildcards = False
.MatchSoundsLike = False
.MatchAllWordForms = False
End With
Selection.Find.Execute Replace:=wdReplaceAll

Options.DefaultHighlightColorIndex = wdViolet
Selection.Find.ClearFormatting
Selection.Find.Replacement.ClearFormatting
Selection.Find.Replacement.Highlight = True
With Selection.Find
 .Text = "with"
 .Replacement.Text = "^&"
 .Forward = True
 .Wrap = wdFindContinue
 .Format = True
 .MatchCase = False
 .MatchWholeWord = True
 .MatchWildcards = False
 .MatchSoundsLike = False
 .MatchAllWordForms = False
End With
Selection.Find.Execute Replace:=wdReplaceAll

Options.DefaultHighlightColorIndex = wdViolet
Selection.Find.ClearFormatting
Selection.Find.Replacement.ClearFormatting
Selection.Find.Replacement.Highlight = True
With Selection.Find
 .Text = "as"
 .Replacement.Text = "^&"
Forward = True
.Wrap = wdFindContinue
.Format = True
.MatchCase = False
.MatchWholeWord = True
.MatchWildcards = False
.MatchSoundsLike = False
.MatchAllWordForms = False
End With
Selection.Find.Execute Replace:=wdReplaceAll

Options.DefaultHighlightColorIndex = wdDarkYellow
Selection.Find.ClearFormatting
Selection.Find.Replacement.ClearFormatting
Selection.Find.Replacement.Highlight = True
With Selection.Find
.Text = "this"
.Replacement.Text = "^&"
.Forward = True
.Wrap = wdFindContinue
.Format = True
.MatchCase = False
.MatchWholeWord = True
.MatchWildcards = False
.MatchSoundsLike = False
.MatchAllWordForms = False
End With
Selection.Find.Execute Replace:=wdReplaceAll

Options.DefaultHighlightColorIndex = wdDarkYellow
Selection.Find.ClearFormatting
Selection.Find.Replacement.ClearFormatting
Selection.Find.Replacement.Highlight = True
With Selection.Find
  .Text = "these"
  .Replacement.Text = "^&"
  .Forward = True
  .Wrap = wdFindContinue
  .Format = True
  .MatchCase = False
  .MatchWholeWord = True
  .MatchWildcards = False
  .MatchSoundsLike = False
  .MatchAllWordForms = False
End With
Selection.Find.Execute Replace:=wdReplaceAll

Options.DefaultHighlightColorIndex = wdDarkYellow
Selection.Find.ClearFormatting
Selection.Find.Replacement.ClearFormatting
Selection.Find.Replacement.Highlight = True
With Selection.Find
  .Text = "those"
  .Replacement.Text = "^&"
  .Forward = True
  .Wrap = wdFindContinue
  .Format = True
  .MatchCase = False
  .MatchWholeWord = True
  .MatchWildcards = False
  .MatchSoundsLike = False
  .MatchAllWordForms = False
End With
Selection.Find.Execute Replace:=wdReplaceAll

Options.DefaultHighlightColorIndex = wdDarkYellow
Selection.Find.ClearFormatting
Selection.Find.Replacement.ClearFormatting
Selection.Find.Replacement.Highlight = True
With Selection.Find
  .Text = "their"
  .Replacement.Text = "^&"
  .Forward = True
  .Wrap = wdFindContinue
  .Format = True
  .MatchCase = False
  .MatchWholeWord = True
  .MatchWildcards = False
  .MatchSoundsLike = False
  .MatchAllWordForms = False
End With
Selection.Find.Execute Replace:=wdReplaceAll

Options.DefaultHighlightColorIndex = wdDarkYellow
Selection.Find.ClearFormatting
Selection.Find.Replacement.ClearFormatting
Selection.Find.Replacement.Highlight = True
With Selection.Find
  .Text = "them"
  .Replacement.Text = "^&"
  .Forward = True
  .Wrap = wdFindContinue
  .Format = True
  .MatchCase = False
  .MatchWholeWord = True
  .MatchWildcards = False
  .MatchSoundsLike = False
  .MatchAllWordForms = False
End With
Selection.Find.Execute Replace:=wdReplaceAll

Options.DefaultHighlightColorIndex = wdDarkYellow
Selection.Find.ClearFormatting
Selection.Find.Replacement.ClearFormatting
Selection.Find.Replacement.Highlight = True
With Selection.Find
  .Text = "they"
  .Replacement.Text = "^&"
  .Forward = True
  .Wrap = wdFindContinue
  .Format = True
  .MatchCase = False
  .MatchWholeWord = True
  .MatchWildcards = False
  .MatchSoundsLike = False
  .MatchAllWordForms = False
End With
Selection.Find.Execute Replace:=wdReplaceAll

Options.DefaultHighlightColorIndex = wdDarkYellow
Selection.Find.ClearFormatting
Selection.Find.Replacement.ClearFormatting
Selection.Find.Replacement.Highlight = True
With Selection.Find
  .Text = "its"
  .Replacement.Text = "^&"
  .Forward = True
  .Wrap = wdFindContinue
  .Format = True
  .MatchCase = False
  .MatchWholeWord = True
  .MatchWildcards = False
.MatchSoundsLike = False
.IsMatchAllWordForms = False
End With
Selection.Find.Execute Replace:=wdReplaceAll

Options.DefaultHighlightColorIndex = wdBrightGreen
Selection.Find.ClearFormatting
Selection.Find.Replacement.ClearFormatting
Selection.Find.Replacement.Highlight = True
With Selection.Find
  .Text = "is"
  .Replacement.Text = "^&"
  .Forward = True
  .Wrap = wdFindContinue
  .Format = True
  .MatchCase = False
  .MatchWholeWord = False
  .MatchWildcards = False
  .MatchSoundsLike = False
  .MatchAllWordForms = True
End With
Selection.Find.Execute Replace:=wdReplaceAll

Options.DefaultHighlightColorIndex = wdBrightGreen
Selection.Find.ClearFormatting
Selection.Find.Replacement.ClearFormatting
Selection.Find.Replacement.Highlight = True
With Selection.Find
  .Text = "have"
  .Replacement.Text = "^&"
  .Forward = True
  .Wrap = wdFindContinue
  .Format = True
.MatchCase = False
.MatchWholeWord = False
.MatchWildcards = False
.MatchSoundsLike = False
.MatchAllWordForms = True
End With
Selection.Find.Execute Replace:=wdReplaceAll

Options.DefaultHighlightColorIndex = wdBrightGreen
Selection.Find.ClearFormatting
Selection.Find.Replacement.ClearFormatting
Selection.Find.Replacement.Highlight = True
With Selection.Find
  .Text = "do"
  .Replacement.Text = "^&"
  .Forward = True
  .Wrap = wdFindContinue
  .Format = True
  .MatchCase = False
  .MatchWholeWord = False
  .MatchWildcards = False
  .MatchSoundsLike = False
  .MatchAllWordForms = True
End With
Selection.Find.Execute Replace:=wdReplaceAll

Options.DefaultHighlightColorIndex = wdBrightGreen
Selection.Find.ClearFormatting
Selection.Find.Replacement.ClearFormatting
Selection.Find.Replacement.Highlight = True
With Selection.Find
  .Text = "make"
  .Replacement.Text = "^&"
.Forward = True
.Wrap = wdFindContinue
.Format = True
.MatchCase = False
.MatchWholeWord = False
.MatchWildcards = False
.MatchSoundsLike = False
.MatchAllWordForms = True
End With
Selection.Find.Execute Replace:=wdReplaceAll

Options.DefaultHighlightColorIndex = wdBrightGreen
Selection.Find.ClearFormatting
Selection.Find.Replacement.ClearFormatting
Selection.Find.Replacement.Highlight = True
With Selection.Find
    .Text = "provide"
    .Replacement.Text = "^&"
    .Forward = True
    .Wrap = wdFindContinue
    .Format = True
    .MatchCase = False
    .MatchWholeWord = False
    .MatchWildcards = False
    .MatchSoundsLike = False
    .MatchAllWordForms = True
End With
Selection.Find.Execute Replace:=wdReplaceAll

Options.DefaultHighlightColorIndex = wdBrightGreen
Selection.Find.ClearFormatting
Selection.Find.Replacement.ClearFormatting
Selection.Find.Replacement.Highlight = True
With Selection.Find
    .Text = "perform"
    .Replacement.Text = "^&"
    .Forward = True
    .Wrap = wdFindContinue
    .Format = True
    .MatchCase = False
    .MatchWholeWord = False
    .MatchWildcards = False
    .MatchSoundsLike = False
    .MatchAllWordForms = True
End With
Selection.Find.Execute Replace:=wdReplaceAll

Options.DefaultHighlightColorIndex = wdBrightGreen
Selection.Find.ClearFormatting
Selection.Find.Replacement.ClearFormatting
Selection.Find.Replacement.Highlight = True
With Selection.Find
    .Text = "get"
    .Replacement.Text = "^&"
    .Forward = True
    .Wrap = wdFindContinue
    .Format = True
    .MatchCase = False
    .MatchWholeWord = False
    .MatchWildcards = False
    .MatchSoundsLike = False
    .MatchAllWordForms = True
End With
Selection.Find.Execute Replace:=wdReplaceAll

Options.DefaultHighlightColorIndex = wdBrightGreen
Selection.Find.ClearFormatting
Selection.Find.Replacement.ClearFormatting
Selection.Find.Replacement.Highlight = True
With Selection.Find
  .Text = "seem"
  .Replacement.Text = "^&"
  .Forward = True
  .Wrap = wdFindContinue
  .Format = True
  .MatchCase = False
  .MatchWholeWord = False
  .MatchWildcards = False
  .MatchSoundsLike = False
  .MatchAllWordForms = True
End With
Selection.Find.Execute Replace:=wdReplaceAll
Options.DefaultHighlightColorIndex = wdBrightGreen
Selection.Find.ClearFormatting
Selection.Find.Replacement.ClearFormatting
Selection.Find.Replacement.Highlight = True
With Selection.Find
  .Text = "serve"
  .Replacement.Text = "^&"
  .Forward = True
  .Wrap = wdFindContinue
  .Format = True
  .MatchCase = False
  .MatchWholeWord = False
  .MatchWildcards = False
  .MatchSoundsLike = False
  .MatchAllWordForms = True
End With
Selection.Find.Execute Replace:=wdReplaceAll

Options.DefaultHighlightColorIndex = wdGray50
Selection.Find.ClearFormatting
Selection.Find.Replacement.ClearFormatting
Selection.Find.Replacement.Highlight = True
With Selection.Find
  .Text = "not"
  .Replacement.Text = "^&"
  .Forward = True
  .Wrap = wdFindContinue
  .Format = True
  .MatchCase = False
  .MatchWholeWord = False
  .MatchWildcards = False
  .MatchSoundsLike = False
  .MatchAllWordForms = True
End With
Selection.Find.Execute Replace:=wdReplaceAll

Options.DefaultHighlightColorIndex = wdGray50
Selection.Find.ClearFormatting
Selection.Find.Replacement.ClearFormatting
Selection.Find.Replacement.Highlight = True
With Selection.Find
  .Text = "very"
  .Replacement.Text = "^&"
  .Forward = True
  .Wrap = wdFindContinue
  .Format = True
  .MatchCase = False
  .MatchWholeWord = False
  .MatchWildcards = False
.MatchSoundsLike = False
.MatchAllWordForms = True

End With
Selection.Find.Execute Replace:=wdReplaceAll

Options.DefaultHighlightColorIndex = wdBrightGreen
Selection.Find.ClearFormatting
Selection.Find.Replacement.ClearFormatting
Selection.Find.Replacement.Highlight = True
With Selection.Find
  .Text = ",ent)>"
  .Replacement.Text = ",\&"
  .Forward = True
  .Wrap = wdFindContinue
  .Format = True
  .MatchCase = False
  .MatchWholeWord = False
  .MatchWildcards = False
  .MatchSoundsLike = False
  .MatchAllWordForms = False
  .MatchWildcards = True
End With
Selection.Find.Execute Replace:=wdReplaceAll

Options.DefaultHighlightColorIndex = wdBrightGreen
Selection.Find.ClearFormatting
Selection.Find.Replacement.ClearFormatting
Selection.Find.Replacement.Highlight = True
With Selection.Find
  .Text = ",ence)>"
  .Replacement.Text = ",\&"
  .Forward = True
  .Wrap = wdFindContinue
.Format = True
.MatchCase = False
.MatchWholeWord = False
.MatchWildcards = True
.MatchSoundsLike = False
.MatchAllWordForms = False
End With
Selection.Find.Execute Replace:=wdReplaceAll

Options.DefaultHighlightColorIndex = wdBrightGreen
Selection.Find.ClearFormatting
Selection.Find.Replacement.ClearFormatting
Selection.Find.Replacement.Highlight = True
With Selection.Find
  .Text = "(ion)>"
  .Replacement.Text = "^&"
  .Forward = True
  .Wrap = wdFindContinue
  .Format = True
  .MatchCase = False
  .MatchWholeWord = False
  .MatchWildcards = True
  .MatchSoundsLike = False
  .MatchAllWordForms = False
End With
Selection.Find.Execute Replace:=wdReplaceAll

Options.DefaultHighlightColorIndex = wdBrightGreen
Selection.Find.ClearFormatting
Selection.Find.Replacement.ClearFormatting
Selection.Find.Replacement.Highlight = True
With Selection.Find
  .Text = "(ize)>"
  .Replacement.Text = "^&"
  .Forward = True
  .Wrap = wdFindContinue
  .Format = True
  .MatchCase = False
  .MatchWholeWord = False
  .MatchWildcards = True
  .MatchSoundsLike = False
  .MatchAllWordForms = False
End With
Selection.Find.Execute Replace:=wdReplaceAll

© John-Michael Davis
With Selection.Find
  .Text = "(ed)>"
  .Replacement.Text = "^&"
  .Forward = True
  .Wrap = wdFindContinue
  .Format = True
  .MatchCase = False
  .MatchWholeWord = False
  .MatchWildcards = True
  .MatchSoundsLike = False
  .MatchAllWordForms = False
End With
Selection.Find.Execute Replace:=wdReplaceAll

Options.DefaultHighlightColorIndex = wdBrightGreen
Selection.Find.ClearFormatting
Selection.Find.Replacement.ClearFormatting
Selection.Find.Replacement.Highlight = True
With Selection.Find
  .Text = "^&"
  .Replacement.Text = "^&"
  .Forward = True
  .Wrap = wdFindContinue
  .Format = True
  .MatchCase = False
  .MatchWholeWord = False
  .MatchWildcards = True
  .MatchSoundsLike = False
  .MatchAllWordForms = False
End With
Selection.Find.Execute Replace:=wdReplaceAll

Options.DefaultHighlightColorIndex = wdGray50
Selection.Find.ClearFormatting
Selection.Find.Replacement.ClearFormatting
Selection.Find.Replacement.Highlight = True

With Selection.Find

  .Text = "(ly)>"
  .Replacement.Text = "^&"
  .Forward = True
  .Wrap = wdFindContinue
  .Format = True
  .MatchCase = False
  .MatchWholeWord = False
  .MatchWildcards = True
  .MatchSoundsLike = False
  .MatchAllWordForms = False

End With

Selection.Find.Execute Replace:=wdReplaceAll

End Sub